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This site is best viewed with Internet Explorer 5x or newer.

Editorial Staff

Managing Editor: Ron Arner
Assistant Editor: Kristy Lantz Astry
Article Editors: Bridget Julian, Jay Mead, Lynnette Reveling
Contributing Editor: Sam Omatseye
Newsletter Staff: Deb Lockwood
Newsletter design by Steve Kavalec and Ron Arner

Technicalities is published bi-monthly by the Rocky Mountain Chapter (RMC) 
of the Society for Technical Communication (STC) and is distributed to 
chapter members, editors of other STC newsletters, and officers of the 
Society.  It is available on request to anyone interested in technical 
communication.  Other STC chapters and publications may reprint material if 
credit is given. 

This newsletter invites writers to submit articles that they wish to be 
considered for publication.

Note: By submitting an article, you implicitly grant a license to this 
newsletter to run the article and for other STC publications to reprint it 
without permission. Copyright is held by the writer. In your cover letter, 
please let the editor know if this article has run elsewhere, and if it has been 
submitted for consideration to other publications.

Readers are encouraged to submit material on subjects of interest to Society 
and chapter members. Please credit repeated material and send a copy of the 
original material to: news@stcrmc.org.

The editor can be reached during the day at 303.956.1906, by e-mail at 
news@stcrmc.org, and by postal mail at 820 S. Monaco Pkwy. #286, Denver, 
CO, 80224. Please submit electronic files in ASCII text format and include a 
telephone number where you can be reached. If you need to mail or fax 
articles and/or artwork, please contact the editor for a mailing address and 
fax number. The deadline for article submission is one month prior to issue 
release (first of the month, every other month).
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The Technicalities staff reserves the right to edit articles for clarity and 
length; substantive editing of feature articles will be reviewed with the author 
prior to publication.

STC RMC 2005-2006 Officers

Administrative Council

President: Marella Colyvas
Vice President: Deb Lockwood
Secretary: Kathy Ramsey
Treasurer: Jessica Betterly
Past President: Marc Lee

Region 7 Director-Sponsor:

John Hedtke

STC RMC Committee Managers

Database: Karen Kraft-Miller
Education: Donald Zimmerman
Jobs/Professionalism: Anne Halsey
List Server: Currently vacant
Membership: Helen Tuttle
Mentoring: Deb Lockwood
Nominating Committee: Ron Arner, Tammy Van Boeing
Programs: Martha Sippel, Frank Tagader
Publicity: Ruth Gaulke
Seminars: Julie Welander
Volunteers: Kim Bell
Web site: Anne Halsey

STC RMC SIG Managers

Contractors and Independent Consultants: Linda Gallagher
Northern Colorado: Ralph Towers
Western Slope: Victoria Thomas

Society for Technical Communication, Rocky Mountain Chapter

General Chapter Business
Rocky Mountain Chapter
Society for Technical Communication
820 S. Monaco Pkwy. #286
Denver, CO 80224
info@stcrmc.org

Job Postings
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Send job postings to jobs@stcrmc.org
Jobs are posted on the chapter website (http://www.stcrmc.org/
jobs_freelance.jobs.htm), and are emailed to the techcomm-discuss mailing 
list.

Chapter website
http://www.stcrmc.org

STC International Office

901 N. Stuart Street, Suite 904
Arlington, VA  22203-1822
703.522.4114
stc@stc.org
http://www.stc.org 
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Technicalities Gets New Contributing Editor

The Technicalities staff is pleased to welcome a new Contributing Editor, Sam 
Omatseye! Originally from Nigeria, Sam has been in the United States since 
1997. He came here on a journalism fellowship, but obtained political asylum 
due to threats from the Nigerian military at the time. He has been teaching 
journalism at Metropolitan State College since the fall of 1998, and has 
written for the Rocky Mountain News, Denver Post, and RCR Wireless News. 
He has also won a number of awards and fellowships.

When asked why he is interested in technical writing, Sam replied:

I am interested in technical writing because it will put me in the 
sequence of learning and imparting information. It is a thrill to 
break down technical information to empower others for their 
businesses, customers and/or clients. I think the technical writer is 
simultaneouly a learner and dispenser of knowledge; a reporter as 
mediator; a physician of sorts, diagnosing and providing solutions. 
In my years reporting wireless technology, I derived joy from being 
a mediator between engineers and the laity. I would really cherish 
an opportunity to fulfill this dream.

Welcome to Our New Members

New, transferred, or returning members for the months of December, 2005 
and January, 2006: 

December 2005

●     Karl R. Anderson 
●     Bob Cermak 
●     John E. Endicott 
●     Marilyn B. Fausset 
●     Stephanie L. Hinsey 
●     Julie A. Landen 
●     Patrick D. Sullivan 
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January 2006

●     Ellen Horowitz 
●     Sarah Ockler 
●     Michael J. Palmer 
●     Christie Ratliff 
●     Dena J. Steward 

Senior Members

Congratulations to the following new or returning Senior Members of the 
Rocky Mountain Chapter:

●     Carol Anderson-Reinhardt 
●     Susan Blaisdell 
●     Maria Brownstein 
●     Bridget Julian 
●     Don Lammers 
●     Meredith Mathews 
●     Jaye Powers 
●     Ronald Sering 
●     Camille Stauffer 
●     Jonathan Woodward
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Solutions, Inc.

Some recent tips, how-to's, and advice from the Rocky Mountain Chapter 
Listserve:

Thread #1:MadCap Software

Is anyone familiar with MadCap Software OR does anyone have any 
information/input/opinion about making the transition from RoboHelp x5 to 
MadCap?

I'm investigating this as an option and was curious about any input my fellow 
STCers could provide. Thank you!!

Flare is in Beta 4 right now and will be released sometime in February to the 
public. How soon were you hoping to convert? Unless there is a pressing 
need, you might want to wait until the typical new-product-bugs are 
smoothed out. Flare is a tremendous product and would definitely be my 
HATT of choice. And MadCap reminds me of the good old days when a 
software company still cared about its users. It will be worth waiting for.

Their Web site is www.madcapsoftware.com. You can sign up to download a 
sneak peak of their final release version due out the end of February. The 
company was founded by former RoboHelp developers who were 
unceremoniously downsized by Macromedia after they bought eHelp. I've 
been impressed by what I've seen of the application so far, though my one 
greatest disappointment is that version 1.0 will not support double byte 
languages, which kills it for us at the present time.

Since the company was founded and operated by former RoboHelp 
programmers, they are promising that Flare will take the next step beyond X5 
plus an easy transition from RoboHelp to Flare. I'd check it out.
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My company needs to distribute a lot of shared content in multiple print and 
online help formats. Most of our deliverables have at least 50% common 
content with other deliverables, and 50% unique content.

I contacted Mike Hamilton (MadCap's VP of Product Management) after the 
WritersUA conference in the spring to find out whether the content in MadCap 
is stored in a database to enable this flexibility or if it is more like a 
conventional HAT. For version 1 at least, it will basically be like a traditional 
HAT. For that reason, we decided to migrate to AuthorIt from our current 
FrameMaker/WWP solution. I wasn't convinced that MadCap is taking a 
progressive enough approach to make content truly usable in multiple formats 
without significant re-work. This may or may not be significant to your 
situation, but it is certainly something to consider before making your 
decision.

We are also currently evaluating AuthorIT as a possible replacement for 
FrameMaker/WWP. I have to admit that I do like the way FrameMaker/WWP 
handles single souring, but the fact that it does not offer any CMS capability 
has us looking elsewhere, especially since our department is scattered across 
several different locations in different states. I also was hoping for a more 
aggressive approach for Flare, but I do think it has a lot of potential and in 
future releases may prove to be everything and more that MadCap is 
promoting.

My opinion is that authoring tools that are not based on a database 
(repository if you prefer techbabble) are obsolete. Those of you that now have 
to transition your content from RoboHelp to something else are enjoying an 
object lesson in why it is so important to separate your valuable content from 
particular tools and formats. More importantly, only a database will allow you 
attain true componentization, customization, and reuse. Flare, like RoboHelp, 
has no database capability.

Thread #2: Frame Font problem on XP

I have a client whose product is going to target older users. I'll be producing a 
hard copy manual for them, and they'd like to know what the "standard" font 
size is for books and journals (they specifically mentioned the Reader's Digest 
Large Print edition) that use large print. Does anyone know if there is a 
"standard" size and what that size is?

Thanks for any input you can provide.

Place your cursor in the row you want to be the header. Select multiple rows 
if it's more than one. Click Table>Table Properties from the menu. Click the 
Row tab. Check the "Repeat as Header row..." checkbox.
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I'm one release back on Word and don't recall that feature. If someone else 
has it, I'm looking forward to it.

(Side question to everyone: what's new in the Word 2003 that is a must-have 
feature?)

One can encode cell content with the Paragraph attribute Keep With Next, 
which effectively keeps the encoded row and following row on the same page 
(Format > Paragraph > Line and Page Breaks).

1I typically use a paragraph style such as CellKeep, based on another 
called Cell, with merely that Keep With Next attribute added in CellKeep.

The last row of the table might be encoded with CellKeep or with Cell, 
depending on the desired pagination.

Related features: 

●     specify that row content may not break across a page boundary (Table 
> Properties > Row) 

●     repeat table header rows on subsequent pages (same place) .

I hope this is helpful.

Oops, sorry, misread your question. Not that I know of.

Not sure if this is the only/best way to do this, but you can format the text in 
the row that you want to keep with the next and in the paragraph formatting, 
in the Line and Page Breaks tab, select Keep with next.

Yes, you can do that in Word.
Place your cursor in a cell of the table row you want to keep with next.
Select Format, Paragraph. The Paragraph dialog box appears. 
Select the Line and Page Breaks tab.
Select the Keep with next option and click OK.

Just to make it unanimous...

As far as I know, you can't set a table row to stay with the next row, but as 

file:///C|/My%20Documents/STC/technicalities/feb_march_06/solutions.htm (3 of 4)3/21/2006 6:50:52 AM



Technicalities - the online newsletter for STC RMC

long as the paragraph inside the row is set to keep with next, it accomplishes 
the same thing.

Word 2003 has a lot of fancy new features, but I wouldn't call any of them 
"must have."

The Reading layout is kinda cool, and there are some nifty features in mail 
merge.

Otherwise, I still turn off as many of the automatic features that it will let me. 
And it's still NOT a desktop publisher, whatever else it might pretend to be.

Thread #3:What if Microsoft designed the iPod box?

I wanted to give you a Friday giggle. This came in yesterday's Windows 
Secrets Newsletter (http://windowssecrets.com). View the video at http://
youtube.com/watch?v=EUXnJraKM3k, but make sure your marketing 
department isn't around. Or perhaps maybe you should simply send it to 
them and get it over with.
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Tips from the Trenches

by Deb Lockwood

Communication between Writers and Editors

As a writer, one of my secret weapons is having an editor. My editor at CSG 
Systems, Inc., (my employer) not only helps me stay on the straight and 
narrow with style and English language corrections, she helps me 
communicate more effectively with my audience. My editor for this newsletter 
corrects my errors and puts the polish on these articles. 

In this article I will share some of the insights that I have gleaned from CSG's 
editors for maintaining effective communication between writers and editors.

What enhances the relationship between a writer and an editor?

●     Communicating openly and honestly 
●     Being flexible while working together (e.g., establishing dates, 

determining needed format or style exceptions) 
●     Approaching things from the perspective of working together for a 

common goal 
●     Working with the editor to negotiate deliverable dates, then respecting 

those deadlines (e.g., the writer gets the documents to editor on time, 
and the editor returns them on time) 

●     Having mutual respect and trust (e.g., don't gossip about someone's 
mistakes around the water cooler) 

●     Agreeing on the project scope (e.g., will the editor edit the entire guide 
or only those sections that have changed)

What hampers the relationship?

●     Taking edits too seriously or personally (both writers and editors) 
●     Sending drafts to editors around noon on the due date, rather than 

early in the day 
●     Acting superior to the other person 
●     Bleeding red ink all over the paper 
●     Making edits that are outside the scope of the project 
●     Missing deadlines, especially when it happens repeatedly 
●     Speaking negatively about the other person 
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●     Going over the other person's head to his or her manager instead of 
first discussing issues with the person

Tips

Tip #1 — Send a survey to your editor (or writer) at the beginning of the year 
requesting feedback on the effectiveness of your communication. Use the 
feedback to take the temperature of your relationship and gather information 
that will help you improve your communication.

Tip #2 — Find out how the other person prefers to communicate (e.g., e-mail, 
telephone, face-to-face) and communicate to him or her in that fashion. 

Tip #3 — For editors, avoid only pointing out errors in edited material. Once 
in a while add a "good job" notation for well-written sections. 

Tip #4 — For writers, make note of an edit that you especially appreciate and 
tell the editor about that edit, thanking him or her for his or her diligence. 

Tip #5 — Remember that you are a part of a team and that you both have a 
common goal: to produce clear, correct, concise content for the reader.

Contributors: Sue Daniel, Barb Krause
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Physical and Virtual Communities

by Marella Colyvas, STC RMC President

By now, hopefully you have renewed your STC membership for the year or 
joined for the first time. I am happy to report that several people have 
emailed or called, inquiring about STC in general and our chapter in 
particular. Look for some new faces at the April meeting!

Despite having a sense that our industry is getting strong again, I am at 
times taken aback by the small number of attendees at our meetings. I 
realize that everyone is busy and that many companies don't reimburse their 
employees for meetings or membership dues; I'm certain that is partly the 
reason for the low numbers. This year we have had the best slate of 
presenters in recent memory — in fact, I've been a member of this chapter 
for over 20 years and I can't remember when we had so much talent to 
showcase. But rather than bemoan the fact of low attendance or exhorting 
you, our members, to come out of your homes and attend the meetings, I 
want to write a bit about the benefits of belonging to a community of 
technical communicators. 

The first benefit that comes to my mind is the chance to meet other like-
minded individuals. By attending the meetings, we can meet technical 
communicators who have amazing talents to share, broaden our contact base, 
and get a leg up on networking. And we can also meet people who charm us 
just by being who they are, giving us an amazing gift in the process. Not only 
does meeting other technical communicators allow us to share in some local 
talent, it gives us the opportunity to grow our own brand of talent-sharing, 
reciprocating in kind with those we meet, and perhaps becoming inspired to 
share first without reciprocating. 

Networking may be key to that next job or contract, and it is also the lifeblood 
of the technical communications industry. The stereotype of the introverted 
writer who works alone in a garret is largely myth. Let's face it, the job 
market has forever changed that image, even for those who actually are 
introverts and lone writers. The reality is that writers have to work with 
people, too. Working in a group teaches you skills like facilitation, diplomacy, 
interviewing, etc. Belonging to a community provides opportunities for you to 
try out these skills in a volunteer position if you are moved to do so, or at the 
very least, in a workshop or forum given by the community where you can 
practice in a safe environment. Such development is key to our profession's 
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growth and credibility. 

The second benefit to belonging to a community of technical communicators 
is the opportunity it affords to, well, communicate, in written form, with the 
community outside of the local group. I'm talking about the opportunity to — 
gasp — write and perhaps be published. Four people in your own Rocky 
Mountain Community just published articles in last month's Intercom: Carol 
Elkins, Bette Frick, and Linda Gallagher and Whitney Broach (writing as a 
team). Why not you next? 

The chance to write is not limited to articles in big publications. The Rocky 
Mountain Community has our own newsletter, which can always use articles 
(contact news@stcrmc.org). And then there are the society-wide, true virtual 
communities. Each SIG has a mailing list where you can share information 
and tips. And, STC has a forum that hosts many different topics. This is the 
first year that I've actually subscribed to the forums and I'm really excited 
about it. There is a writing and editing forum that hosts discussions about the 
creativity of our members and writing in general. Check the forums out at 
http://stcforum.org/index.php. A commitment I have made to myself this 
year is to post something every week to at least one forum topic. As any 
writer knows, the more one writes, the better a writer one becomes. 

Besides increasing writing skill and gaining insight into problems and 
challenges in the varied areas of technical communication, I think there is a 
second, less tangible benefit to the virtual communities: forums, blogs, 
mailing lists, and instant messaging create a sense of camaderie that 
transcends geographies and cultures. A virtual community creates its own 
culture. Our daughters and sons who were born into the information age have 
grasped this reality much faster than many of us who have worked with 
technology for years - witness the proliferation of instant and text messaging, 
as well as blogging/sharing spaces like http://myspace.com. Virtual 
communities also teach you to be alert, and not to immediately trust what 
meets the eye — like in any good communication, the writer of a blog or 
forum post has to be clear, concise, and honest if they are to be credible. 

Here's an interesting article by Judith Herr, moderator of the Writing and 
Editing Forum and the manager of the Management SIG, where she shares 
thoughts about writing and being part of a virtual community in the very first 
article: http://www.stcsig.org/mgt/news/January2006Directives.pdf. This 
article is excellent! In fact, I loved the entire newsletter - especially the article 
"Technical Writer, Art Thou Artist?" by Janani Gopalakrishnan. 

The benefits of STC communities, whether they be physical or virtual, are 
many. I encourage you to take them to heart and start reaping their many 
advantages — and you might actually learn something along the way. 

 Technicalities Home  
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You Can't Clean Clutter Without Purging

by Ron Arner

If you want to clean out clutter, the first thing you have to do is purge. Many 
tech comm employees learned this the hard way when the economy collapsed 
and we were forced to deal with layoffs, learn new skills, or find more 
innovative ways to practice our trade. We've recently seen the benefits of 
purging as an organization with the restructuring of the STC on an 
International level. Some purging has gone on at the local level as well, and 
now I think it's time to step back, examine what we're all about, and really 
decide what we're going to keep and what we're going to get rid of.

Our President, Marella Colyvas, refers to this issue in her current column 
when she talks about low meeting attendance despite the fabulous slate of 
presenters lined up for us this year by Martha Sippel and Frank Tagader. Sam 
Omatseye, a new member of the Technicalities staff, raises this issue on a 
more national level in his column about the slide in U.S. science and 
technology.

Is our chapter headed in the right direction? Have the changes that have been 
made been what you want? What more can we do to continue to be a growing 
community of the best technical communicators in the Rocky Mountain 
Region? The important factor in all this is what you, the members of the STC 
RMC, want from a professional organization, and there's no way for chapter 
leadership to know what you want without your feedback.

As a member of several STC listserves, it's interesting to see how other 
chapters operate. One thing I've noticed is that some chapters definitely 
appear to be stronger than others in regards to enthusiasm, participation, and 
effectiveness. By effectiveness, I'm referring to what members of the chapter 
think about it, how well it meets their needs, how often they participate in or 
volunteer for things, etc. It seems to me that the stronger chapters don't 
necessarily operate in a strict, business-like fashion (I think maybe we get 
enough of this elsewhere), but rather function as both a professional 
development and networking/social organization. Again, the key to chapter 
leadership's ability to do this is the feedback of its members.

Here are some suggestions as to how you can give some feedback right 
away: 
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●     Participate in both the STC International and chapter elections. If you 
don't vote, you're not allowed to complain about the outcome. 

●     Contact a chapter officer and just let them know what you think about 
the STC RMC in general. 

●     Write an article for the next issue of the newsletter about where you 
think our chapter should be headed, or just send a letter to the editor. 

Now before I get down off my soapbox, let me say that I'm no stranger to 
clutter. After several years of moonlighting and going to school, my house 
was a disaster. I welcomed Hellen Buttigieg from the Discovery Home 
Channel's program Neat into my house like she was an angel of mercy. What 
impressed me about her show is that whenever she goes into a cluttered 
home, the first thing she has the inhabitant(s) do is purge, or separate their 
belongings into keep, give away, and throw away classifications. Then comes 
the re-design, the purchase of adequate storage containers, and, of course, 
"the reveal," where the recipient of the newly organized space says they've 
never seen anything so beautiful. I'm taking Buttigieg's advice to heart in my 
own home, and with some feedback from you, the members of the STC RMC, 
I think the STC RMC can do the same.

 Technicalities Home  
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Subsetting and Customizing DITA

by Bernard Aschwanden

(Reprinted with permission. A complete copy of the 4000-word original 
version of this article in PDF, HTML and XML formats can be found online at: 
www.publishingsmarter.com.)

This article explores ideas related to subsetting and customizing the DITA 
(Darwin Information Typing Architecture) specification without the addition of 
new elements. Instead, we explore taking default rules and adapting them to 
meet the needs of specific writing and publishing environments.

About DITA

DITA is an XML-based, end-to-end architecture for authoring, producing, and 
delivering technical information. This architecture consists of a set of design 
principles for creating “information-typed” modules at a topic level and for 
using that content in delivery modes such as online help and product support 
portals on the Web.

Subsetting versus specialization

To help clarify the difference in meaning between subsetting and 
specialization, consider an example that relates to the use of the 26 
characters of the traditional English alphabet; that is, the letters A through Z. 
Generally, the idea of subsetting is similar to that of removing letters of the 
alphabet.

Consider a subset containing only the five principle vowels, AEIOU, and the 
letters RLSTN. Through the subset of these 10 letters we can create words 
like stone, lesson, rail, station, institutional, satin and so on. Each of these 
words is easily recognized as a well formed word by users of the full set of 26 
letters. It is also recognized by users of the subset. However, the words 
frequency, subtle or railway would not be recognized by the subset.

Therefore, subsetting, in the context of this document, means to remove or 
reorganize elements, attributes and attribute values to customize the way 
that options are presented, while ensuring all the DITA specifications are 
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followed. Specialization is the general process by which additional elements 
are added to the DITA specification to allow for custom development of new 
information types.

Why subset and modify DITA

There are numerous reasons to consider customizing the DITA specification 
either through subsetting or through specialization. The three main reasons to 
subset include changing default tags, modifying the order or elements and 
adjusting the frequency of element use.

Default tag set

The default tags in the DITA specification include close to 200 elements. In 
many cases, tags provide features that are not required in your 
documentation or provide undesired redundancy. Many tags can be removed 
from the architecture and still leave all the structure authors need. This can 
be done without specialization.

Default element order

The order of elements in the DITA specification is incredibly flexible. This 
means that elements can be inserted in a variety of ways. The result is 
documents that allow writers the freedom to write. However, that freedom 
may result in writers skipping some elements or inserting others in an order 
that doesn’t adhere to your style guide. Modifications to the default element 
order allow restrictions to the organization of information. If this still adheres 
to the principles of the DITA specification your content remains compliant and 
your authors have a guided workflow.

For example, within the step of a given task, the DITA specification allows 
numerous additional elements in any order. This includes:

●     info (information to provide additional information about the step)
●     substeps (to break a step down into a series of separate actions, 

recommended in the DITA specification to be used only if necessary)
●     tutorialinfo (information that is included in a step when a task is part 

of a tutorial)
●     stepxmp (used to provide a specific example of a step of a task)
●     choicetable (contains a series of optional choices available within a 

step of a task)
●     choices (used when the user will need to choose one of several actions 

while performing the steps of a task)

Default element frequency

Many of the elements in the DITA specification allow child elements to appear 
with no restrictions. This means that, basically, authors can insert a wide 
variety of elements as often as desired. Ironically, this may result in 
undesired content, such as a step made up of a cmd, followed by an 
unlimited number of info child elements.
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Sample subsetting of a DITA element

As a practical example of subsetting within the DITA specification, consider 
the step element. This element has numerous default child elements with few 
limitations placed upon them. By defining a subset of the step element we 
allow authors to create content while ensuring specific guidelines are followed. 
This ensures clear content is created within the DITA specification. All output 
is also fully compliant with the DITA specification. We therefore enforce a 
custom style of writing while following the DITA specification.

Default rule of step

Before we modify any elements, let’s begin by reviewing the default rules that 
the DITA specification enforces when working with the element step. The step 
element specifies: cmd then (info or substeps or tutorialinfo or stepxmp or 
choicetable or choices) (0 or more) then (stepresult) (optional).

Therefore, using the default a writer can create the following type of content:

1.  Select File > Save As.
2.  Select a filetype under Save as type.

For example, choose Web for the internet or choose Document for a 
local file.

This lets you specify the export format.

a.  select Web
b.  select a location
c.  enter a file name

or you could

a.  select Document
b.  select a location
c.  enter a file name

After you perform this substep continue to save your file.

3.  Click OK.

The step contains numerous elements; some of which repeat and appear in 
an order that may not be repeated the next time the element step is used. 
By developing a custom rule additional restrictions can be enforced for 
consistency within your organization.

Custom rule for step

The development of a custom rule should always be done with the confidence 
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that output will still match the DITA specification. Basically, if the DITA 
specification allows an element to have numerous optional child elements, it is 
relatively simple to remove any of them. Since child elements are optional, 
removing them has no negative impact on output. If the child is required, 
then subsetting should not be done as the output will not meet the DITA 
specification.

An example of a custom definition of step is seen below:

cmd, (info, choices?)? 

Therefore, using a custom definition a writer can create the following type of 
content:

1.  Select File > Save As.
2.  Select a filetype under Save as type.

For example, choose Web for the internet or choose Document for a 
local file.

This lets you specify the export format.

a.  select Web or Document
b.  select a location
c.  enter a file name

3.  Click OK.

The step contains a required cmd element. After the cmd there is a single 
info and a choices element. Nothing beyond this limited subset is allowed. 
Authors can not insert examples, multiple strings for info, numerous choices 
and more. The restriction helps to ensure consistency and provides more 
detailed guidance for each of the authors when working with a step.

Result of subsetting step

The result of the customization is a document set that is more professional, 
consistent and easier to manage. Editing and translation are simplified as 
there are fewer decisions that need to be made based on writing style.

Subsetting tags

There are close to 200 tags in the DITA specification. One of the easiest 
things you can do to make a DITA implementation simpler is to reduce the 
number of tags.

High level DITA elements

Numerous high level elements exist in the DITA specification and several can 
be safely removed when subsetting. It is important to first plan your 
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document set and then begin to subset as the removal of high level elements 
and all associated child element is difficult to undo later. Also ensure that any 
element that is removed is not required elsewhere in the DITA specification. If 
it is, ensure you make appropriate modifications in all locations.

Common attributes

There are also several attributes that are commonly used throughout the 
DITA specification that may not be required. As with elements, it is important 
to plan your document set and then begin to subset. Remember that many of 
the attributes are reused throughout the DITA specification and it may be 
better to remove them on an element by element basis rather than removing 
them from the DITA specification completely.

Subsetting occurrence indicators and order

The frequency of elements in the DITA specification can be subset. Since the 
majority of elements are optional, removing them poses no significant impact 
in the compliance of your content with the DITA specification.

Subset step

As seen earlier in this article, the element step can be subset as required.

Another example of a subsetting of the default definition of the element step 
may appear as seen below:

cmd, info? 

This new rule still matches the DITA specification. However, it has been 
customized to specify that a cmd must be inserted. Then, if required, info 
may be added, but only once.

Drawbacks to subsetting

There are two key drawbacks to consider before subsetting: tab limitation and 
stricter rule requirements. If a DITA implementation is well planned neither 
should be a major problem in managing the way DITA is used.

Tag limitation

While subsetting helps to implement a stricter implementation of the DITA 
standard, it also deviates from it. By only supporting a key set of tags you 
restrict the ability to import other content that complies with the DITA 
specification.

Stricter rule requirements

By redefining the order of elements and their frequency, you effectively rule 
out some combinations of elements that others may use. In doing so, you 
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may be limiting the usefulness of content that others provide that match the 
DITA specification.

Conclusion

Subsetting the DITA specification and modifying the default rules can provide 
many benefits to an organization. A restricted set of elements reduces the 
need to develop formatting and transformation rules for all possible 
combinations of elements. It also allows organizations to further control the 
types of content used and the way that they are used. This results in far more 
consistent documentation.

As long as any subsetting and modification of the rules is done in such a way 
that compliance with the DITA specification is assured in your output, then 
subsetting can be beneficial. The key is to plan based on your current 
documentation environment and to also plan for any future implementations 
that are expected.

Custom implementations of most XML architectures from DocBook to S1000D 
to the DITA specification happen all the time. By restricting tags and enforcing 
custom order your DITA implementation can be done quicker, with more 
reliable results and at a lower overall cost of development, training and 
implementation.

Upcoming events

The author of this article is involved in several events in 2006.

●     2006 DITA Conference, March 23 to 25 

conf.travelthepath.com 

●     FrameMaker and DITA Seminar, March 3, May 5 

www.pubsnet.com 

●     Toronto STC Spring Conference, March 27 to 29 

www.stctoronto.org 

●     DITA Summit, June 7 

www.pubsnet.com 

Related materials

A variety of related materials can be found online, including a set of 
FrameMaker specific documents for developing and publishing DITA content 
using a custom subset:
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●     Introduction to DITA 

www-128.ibm.com/developerworks/library/x-dita1/ docs.oasis-open.
org/dita/v1.0/archspec/ditaintro.html 

●     Author Site, including a fully functional DITA and FrameMaker sample 
document set. 

www.publishingsmarter.com 

Tools used to develop this article

As the saying goes “we eat our own dog food”. In an effort to prove that DITA 
can be used to author content, and to deliver it in numerous formats, we 
created this entire article using readily available tools. Content was converted 
as required via numerous transforms provided with the DITA toolkit.

Author information

A recognized publishing technologies expert, Bernard Aschwanden presents at 
conferences and events across Europe and North America. Bernard is an 
Adobe Certified Expert, a Certified Technical Trainer and the author of 
numerous publications on publishing and single sourcing including Advanced 
FrameMaker, published by TIPS Publishing.

The founder of Publishing Smarter, a senior member of the Society for 
Technical Communication, the Vice President of the Toronto STC and Past 
President of the Computer Trainers Network, Bernard has helped hundreds of 
companies implement successful publishing solutions. Bernard is focused on 
publishing better, publishing faster and publishing smarter.

Home Page: http://www.publishingsmarter.com

Email: dita@publishingsmarter.com
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Alarming Slide in U.S. Science and Technology

by Sam Omatseye. You can find a short bio of Sam, the newest member of 
the Technicalities staff, on the Chapter News page of the current issue.

Rising Above The Gathering Storm: Energizing and 
Employing America for a Brighter Economic Future
Committee on Prospering in the Global Economy of the 
21st Century: An Agenda for American Science and 
Technology, National Academy of Sciences, National 
Academy of Engineering, Institute of Medicine. 2006. 
Washington, D.C.: National Academies Press. [ISBN: 
0309100399. 504 pages.]

While terrorism may be perceived as the clear and 
present danger to the American way of life, another 

threat lurks, which many observers believe to be far more insidious. This 
threat is what experts in many fields describe as America's slide in science 
and technology leadership. President George W. Bush outlined this in his 
State of the Union address. Members of Congress are also agitated, which has 
prompted them to commission a study by the National Academy of Sciences. 
The NAS returned its report titled Rising Above the Gathering Storm: 
Energizing and Empowering America for a Brighter Economic Future this year.

This is not the first study on the subject. The Electronic Industry Alliance, the 
Business Roundtable, and the Council of Competitiveness have also unveiled 
reports that present the same conclusion: that the United States' slide is real, 
and all resources should be summoned to arrest it as soon as possible.

"It is the unanimous view of our committee that America today faces a 
serious and intensifying challenge with regard to its future competitiveness 
and standard of living," said Norman Augustine, retired chairman of Lockheed 
Martin Corp. before the U.S. House of Representatives. He was one of 20 
members who conducted the study for the NAS. In his recent book, The World 
is Flat: A Brief History of the Twenty-first Century, New York Times Columnist 
Thomas Friedman also hinted at this challenge.

The NAS report also stated that the outsourcing of low- and high-end jobs to 
some developing countries may just be the tip of the iceberg. The "scientific 
and technical building blocks of our economic leadership are eroding at a time 
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when many other nations are gathering strength." The United States could 
lose its lead abruptly and that lead could be difficult to regain, "if indeed it can 
be regained at all."

The foreign culprits in this drama include China, India, South Korea, 
Singapore, Taiwan, and a raft of so-called Asian tigers, who are exploiting the 
high cost of labor and emerging technologies to chip away at US dominance 
according to the report.

"For the cost of one chemist or one engineer in the United States, a company 
can hire about five scientists in China or 11 engineers in India," explained the 
report. "Chemical companies closed 70 facilities in the United States in 2004 
and have tagged more for shutdown." In the past few years, the clamor to 
arrest the outflow of U.S. jobs abroad has been rising, but the outsourcing 
alone may not explain the slide of science and technology leadership. 
Outsourcing may be a consequence of practical economics. Cheaper labor 
abroad is trumping the need to pay costlier employees at home.

In spite of a surge of outsourcing, the United States still enjoys clear 
advantages over the rest of the world. But outsourcing may create the setting 
for a slide among other factors. One of the features of outsourcing includes 
setting up research and development centers in foreign countries. This means 
that the United States, which has historically provided the bulk of the 
research dollars available within its borders, may be enabling other countries 
and citizens to develop tomorrow's cutting-edge ideas, discoveries, and 
technologies.

Another reason for the slide is that fewer U.S. citizens are majoring in the 
sciences in college. The report shows that in the major graduate schools in 
the country, the majority of the students are foreign-born. In the past, 
foreign students often remained in the country after graduation, and then 
ploughed their expertise back into the country. Now, however, more and 
more foreign students return home. With the preponderance of outsourcing of 
jobs to India, China, and other developing countries, graduates can get the 
same jobs that America normally offered them. Visa problems can also drive 
them back home. 

The NAS study, which was conducted by 20 professionals in a wide variety of 
fields, recommended major steps to Congress. They were as follows:

●     Increase America's talent pool by boosting K-12 mathematics and 
science education 

●     Sustain and strengthen the nation's commitment to long-term basic 
research 

●     Develop, recruit, and retain top students and engineers from both the 
United States and abroad 

●     Ensure that the United States is the premier place in the world for 
innovation

Augustine lamented that "our students will not have the purchasing power to 
support the standard of living which they seek, and to which many have 
become accustomed; tax revenues will not be generated to provide strong 
national security and healthcare; and the lack of a vibrant domestic consumer 
market will provide a disincentive for either U.S. or foreign companies to 
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invest in jobs in America."

The report also calls for the United States to recruit 10,000 science and 
mathematics teachers with an incentive of four-year scholarships of up to 
$20,000 per year for majors in mathematics, physical or life sciences, and 
engineering. Such students will be required to teach K-12 students for five 
years. A $10,000 bonus will go to those who teach in rural and inner-city 
schools. "Teachers must gradually be held accountable for majoring in the 
areas they teach, especially when the areas are math and science, and for 
demonstrating that they have mastered those subjects by passing rigorous 
tests," remarked the New York Times in an editorial on January 24, 2006.

To sustain long-term research, the NAS report further recommended a 10-
percent increase in federal investment in research each year for seven years. 
It also suggested new research grants of $500,000 a year for five years to 
200 of the sharpest early career researchers. It said the United States should 
establish a "creative, out-of-the-box transformational generic energy 
research" without the support of industry.

As a magnet for the smartest students, the NAS recommended 25,000 new 
undergraduate scholarships of up to $25,000 a year to U.S. students in 
mathematics and science. To maintain the U.S. lead in innovation, it 
recommended protection of our intellectual property.

The access to new technologies by developing countries has led to what many 
see as copycat replications of US inventions and discoveries. In the wireless 
industries, China claims to have developed what it calls a proprietary 
technology called TD-SCDMA. But U.S. players believe that it is an 
adulteration of U.S. products, which include TDMA and Qualcomm Inc.-made 
CDMA technologies. One of China's major firms is Huawei Technologies, and it 
is in the frontlines of promoting the Chinese technology over the American, 
but that has not stopped U.S. major players from investing in the market. 

Motorola Inc., Lucent technologies inc., Texas Instruments, and other 
Western firms like Siemens, Nokia, and Ericsson have invested huge sums of 
money and personnel in the markets in China and India. They also partner 
with them in developing technologies, a practice that opens the way for the 
local engineers to learn the tricks and possibly create their cutting-edge 
technologies. This trend underlines the United State's superior position, and it 
also foreshadows its vulnerability once the apprentice hones the master's 
craft. That's why concerned individuals, professionals, the U.S. Congress, and 
the president are stressing urgency of action in this matter.

 Technicalities Home  

file:///C|/My%20Documents/STC/technicalities/feb_march_06/feature4.htm (3 of 4)3/21/2006 6:51:01 AM



Technicalities - the online newsletter for STC RMC

© Copyright 2005
Rocky Mountain Chapter, Society for Technical Communication; all rights reserved. 

Standard disclaimers apply. 

file:///C|/My%20Documents/STC/technicalities/feb_march_06/feature4.htm (4 of 4)3/21/2006 6:51:01 AM

http://www.stcrmc.org/disclaim.htm


Technicalities - the online newsletter for STC RMC

 

February/March 2006 Volume 46, Number 4

.pdf Version Masthead Archives   

Technicalities Home

Columns:

Message from the Editor

President's Corner

Tips from the Trenches

Solutions, Inc.

Chapter News

Features:

STC RMC Associate 
Fellows

January Chapter Meeting 
Review

A Personal Saving Plan 
that Works

Alarming Slide in U.S. 
Science and Technology

Subsetting and 
Customizing DITA

STC RMC Home

STC International Home

Tax tip: A Personal Savings Plan That Works

by Geoff Hart, Associate Fellow, Montreal Chapter

Originally published by the STC CIC SIG. Reprinted with permission. 

As a parent of two teenage kids, the concept of going freelance originally 
scared me silly. In particular, I'd never really run a business before and 
accounting was just one of those things my brain never seemed capable of 
handling. (It turned out to be easier than I'd feared, fortunately.) One of my 
biggest worries was how to ensure that come year-end, I'd have enough 
money left over to cover my tax liabilities.

A little thought provided a solution that works particularly well for me and 
that keeps me from spending money I don't have. Better still, it creates an 
enforced savings plan I can live with and that requires minimum overhead on 
my part. In this article, I'll describe how it works.

But first, a word of caution: It's important to remember that as freelancers, 
we must always keep a well-stocked reserve of money, often referred to as 
an "operating reserve" or "emergency fund", that will cover our expenses for 
at least 3 months and preferably for longer. This sum is what we'll survive on 
during dry spells when there's no work, or during life crises such as a sudden 
injury or illness that prevent us from working. The only goal of the reserve is 
to keep us financially alive until our business revives or our disability 
insurance kicks in. If you haven't built up such a reserve, creating one should 
be a priority. I built mine slowly by forcing myself to put aside money while I 
was a wage slave so that it would be ready when I made the leap.

My solution was to create a very simple spreadsheet that I use to track my 
income and expenses. The "income" page contains the following columns:

●     Column 1: Details on the work-often just an invoice number that 
contains the client's name. 

●     Column 2: The fee charged for the service, excluding relevant taxes. 
●     Columns 3 and 4: Federal and provincial sales taxes. (In the U.S., 

replace "provincial" with "state".) 
●     Column 5: The total of the previous three columns.

At the bottom of the spreadsheet, I total each of the numerical columns, 
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thereby providing a constantly updated running total. Below these totals, I 
have three additional rows, each of which represents one of the three overall 
Canadian tax brackets. For each row, I calculate my income tax based on the 
tax rate for the corresponding tax bracket, but here's the trick: I don't include 
any personal deductions or exemptions in that calculation. The result is that 
the column totals for sales tax tell me my total sales tax burden, and the row 
totals for each tax bracket tell my my maximum income tax liability.

(With a little more sophistication, I could create a single formula that 
calculates the tax liability, but I was still learning the basics of Excel when 
I developed this approach.) Each time I add a new paid invoice to the 
spreadsheet, my maximum tax liability (income plus sales) is updated at 
the bottom of the sheet. When I deposit each new cheque at my bank, I 
pause for a moment to ensure that the current balance in my financial 
reserve—a special short-term savings account that I'll describe in more 
detail in a moment—is larger than my total tax liability based on the 
spreadsheet. If not, I transfer enough of the new cheque to top up the 
account and cover my liability. Anything that remains becomes disposable 
income. By the end of the year, I not only have enough money to pay my 
taxes, but I also have an additional sum (usually a large one) that arises 
from how I chose to calculate my taxes: with no deductions or personal 
exemptions included, the calculated tax bill will always be higher than my 
real tax bill. Barring any emergency expenditures that force me to dip into 
my reserve, I'll always have money left over at year-end. Some years, I 
even get a tax rebate on top of the enforced savings. In any event, any 
extra money that isn't required in my short-term reserve goes straight 
into retirement or other long-term savings.

The "short-term savings" account that I referred to earlier is more than just a 
regular bank account, because such accounts pay essentially zero interest. In 
my case, it means a money-market mutual fund that earns a steady, 
unspectacular rate of return with maximum security because the money is all 
invested in government bonds and similarly safe investments. The low 
interest rate is an acceptable trade-off for obtaining high security and near-
immediate liquidity: I can extract the money with 1 day's notice, and there's 
no "load" (purchase or redemption charge) to either buy more units of the 
fund or redeem existing units when tax time rolls around. If you have more 
money available and are willing to lock in your savings for longer periods, 
"guaranteed investment certificates" (Canada) or a "certificate of deposit" (U.
S.) may make more sense because these investments often offer higher rates 
of return. If you're a gambler, you can invest in riskier but higher-return 
investments such as stock funds, but I don't recommend this approach; the 
sole purpose of this savings account is security and liquidity, not a high rate 
of return.

Your financial circumstances may dictate a slightly different strategy. For 
example, if you're living hand to mouth, you may have little money left over 
to top up your reserve. Conversely, if you're earning far more money than 
you need to cover your expenses, you can make additional deposits or top up 
your long-term savings. The key is to have the discipline to sacrifice a little bit 
of comfort while you're building up your reserve so that you can relax a bit 
and spend more freely in the future. It's worked like a charm for me, and with 
a little modification, it'll work for you too.
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Putting Personas to Work: January Chapter 
Meeting Review

by Ron Arner

On January 19th, Whitney Quesenbery of Whitney Interactive Design taught 
STC RMC members how to make usability more human through the use of 
personas.

What are personas?

Personas are much more informative than the standard, generic user profile, 
which is little more than a list of demographic data. Personas are portraits. 
They make users into true individuals by telling their stories, rather than just 
detailing a few of their common traits like age, education, and computer 
experience. Telling stories about our users, gives them more "specificity and 
context", making it easier to design for them.
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How do you create personas?

Here are some simple steps to help you create personas by writing stories 
about your users:

Establish a goal and context

●     Why is your persona using the product? 
●     What will make this interaction successful?

Describe the interaction

●     Stay at a high level, and 
●     Avoid detailed descriptions of the interface

End with the result

●     What happens as a result of this interaction? 
●     What made it a success?

Why personas?

Quesenbery's background in theater inspired her pursuit of personas for many 
reasons, not the least of which was the transition from a "forty foot wide stage 
to a fourteen inch wide screen." She was also frustrated by the simple 
demographic information that most user profiles provide, and wanted to know 
more about her audience. Thus, her practice of using personas was born in 
order to make better design decisions. And since personas are simply stories, 
they can be used even if you can't do any direct user research at all.

Quesenbery also clarified that different stories come into play during different 
phases of the design process. In the early stages of design, evocative stories 
are used to help deal with needs, goals, barriers to overcome, etc. Eventually, 
you get to prescriptive stories, which are full of the perceptions, decisions, 
and sequences of action you will consider while completing your design.

For more information on Quesenbery or personas you can visit her Website at: 
Whitney Interactive Design or reach her by email at: whitneyq@wqusability.
com.
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Three STC RMC Members Elected STC Associate 
Fellows

by Linda Gallagher, Martha Sippel, and Deb Lockwood

Three STC RMC members were elected associate fellows at the January STC 
board meeting. The rank of associate fellow is conferred only upon a senior 
member who has attained distinction in the field of technical communication. 
Any STC chapter or member can recommend senior members who meet the 
minimum requirements. A committee composed of STC fellows and associate 
fellows then reviews the candidate biographies and determines their 
nominations. The STC Board must then approve the committee's nominees. 
Associate Fellows will be honored at the honors reception and banquet for all 
newly elected fellows and associate fellows at the 2006 STC Annual 
Conference in Las Vegas in May. Congratulations to our new Associate 
Fellows! 
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